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Typographic Conventions 
Type Style  Represents 

Example Text Words or characters that 
appear on the screen. These 
include field names, screen 
titles, pushbuttons as well as 
menu names, paths and 
options. 

Cross-references to other 
documentation 

Example text Emphasized words or phrases 
in body text, titles of graphics 
and tables 

EXAMPLE TEXT Names of elements in the 
system. These include report 
names, program names, 
transaction codes, table 
names, and individual key 
words of a programming 
language, when surrounded by 
body text, for example, 
SELECT and INCLUDE. 

Example text Screen output. This includes 
file and directory names and 
their paths, messages, names 
of variables and parameters, 
source code as well as names 
of installation, upgrade and 
database tools. 

Example text Exact user entry. These are 
words or characters that you 
enter in the system exactly as 
they appear in the 
documentation. 

<Example 
text> 

Variable user entry. Pointed 
brackets indicate that you 
replace these words and 
characters with appropriate 
entries. 

EXAMPLE TEXT Keys on the keyboard, for 
example, function keys (such 
as F2) or the ENTER key. 
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1 Introduction 
Excel Add-In allows you to seamlessly integrate the capabilities of the SAP BusinessObjects 
Strategy Management environment into your Microsoft Excel solutions. 

You can use Excel Add-In to select and arrange data from a dimensional model in a Microsoft 
Excel worksheet. Excel Add-In appears in the Excel program with its own menu and toolbar. 

Using Excel Add-In, you can perform the following tasks: 

 Log in and out of Application Server. 

 Select and arrange the view of Application Server data by dragging dimensions and variables 
on the Viewer tab of the Dimensional Model dialog box. 

 Specify a different dimensional model to use. 

 Drill up and down on data — you can choose whether to display the parent level or remove it 
when drilling down. 

 Create multiple views of Application Server data from different databases in a single Excel 
worksheet. 

 Copy Application Server data to other worksheets and rearrange the display. 

 Update a worksheet with the most current data from Application Server. 

 Attach the SM Add-In  toolbar to the Excel toolbar, change the toolbar shape, or customize the 
toolbar. 

 Get Help on using the Excel Add-In. 



Excel Add-In Defaults and Maximums  

 

 

6 September 2011 

 

2 Excel Add-In Defaults and 
Maximums 

Defaults 
 If you select a dimension in the dimensional model without selecting members in the 

Dimensional Selector, the result member (the top-most member to which you have access) of 
the dimension is displayed by default. 

 The default database is the current Use database in Application Server. 

Maximums 
 The maximum total number of bytes of information in a single row is 8192 bytes. 

 The maximum number of columns on in a report is 256. 

 A Application Server variable can be dimensioned by a maximum of fourteen dimensions, 
including the mandatory dimensions, Time and Measures. 

 You can display a maximum of six dimensions across and six dimensions down the worksheet 
as long as the total sum of displayed dimensions does not exceed eight. 

 An Excel worksheet can contain a maximum of 256 columns and 16,384 rows. However, you 
can display a maximum of 15,000 data rows from a dimensional model source. 

 Although you can run multiple instances of Excel, you can log into Interactive Publisher in only 
one of those instances. 
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3 Getting Started 
The SM Add-In toolbar and menu appear in the Excel window if the Strategy Management option is 
selected in the Add-Ins dialog box. 

Procedure to load Excel Add-In 
1. Choose Tools  Add-Ins to display the Add-Ins dialog box. 

2. Do one of the following: 

 If Strategy Management appears in the Add-Ins list box, select the option. 

 If Strategy Management does not appear in the Add-Ins list box, click Browse to locate the 
file ASVEXCEL.XLL, which resides in the directory where you installed strategy 
management components. When you have located the file, double-click the filename. 

3. Click OK to close the Add-Ins dialog box. 

Procedure to exit from Excel Add-In 
Close Microsoft Excel. 

Procedure to unload Excel Add-In 
1. Choose Tools  Add-Ins to display the Add-Ins dialog box. 

2. In the Add-Ins Available list box, deselect Strategy Management, and then click OK. 

Note:  The Strategy Management option will still be listed in the Add-Ins dialog box the next time 
you display it. To remove the option permanently, uninstall Excel Add-In. 

Procedure to uninstall Excel Add-In 
1. Unload Excel Add-In. 

2. Click the Start button on the taskbar, point to Settings, and then click Control Panel. 

3. In the Control Panel, double-click the Add/Remove Programs icon to display the Add/Remove 
Programs Properties dialog box. 

4. Click the Install/Uninstall tab. 

5. In the list box, select Excel Add-In, and then click Add/Remove. 

6. When a message box appears, prompting you to confirm the removal of the selected 
application, do one of the following: 

 Click Yes to uninstall Excel Add-In. 

 Click No to cancel the Uninstall program. 

7. When the Uninstall program has completed, click OK. 

8. Click OK to close the Add/Remove Programs Properties dialog box. 
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4 Using Excel Add-In 
4.1 Displaying Menus and Dialog Boxes 

and View Names 
Displaying shortcut menus 
You can display shortcut menus by right-clicking the following items: 

 A cell within the dimensional model data in the worksheet. 

 The SM Add-In toolbar 

 A custom button on the SM Add-In toolbar 

Procedure to display the Dimensional Model dialog box 
1. In the worksheet, select a cell within the dimensional model data. 

2. Do one of the following: 

  Click SM Add-In  Properties. 

  Click the Properties button on the SM Add-In toolbar. 

  Display the shortcut menu, and then choose Properties. 

Procedure to display the Dimensional Selector 
1. In the worksheet, select the label of the dimension you want to work with. Or, select a cell 

within the dimensional model data. 

2. Do one of the following: 

  Click SM Add-In  Selector. 

  Click the Selector button on the SM Add-In toolbar. 

  Display the shortcut menu, and then choose Selector. 

If you selected a dimension in the worksheet in step 1, the Dimensional Selector displays 
details of the selected dimension — otherwise, details of the Measures dimension (variables) 
are displayed. 

Procedure to list the view names in the worksheet 
Do one of the following: 

 Choose Insert  Name  Define to display the Define Name dialog box, where you can see a 
list of the view names in the worksheet. 

 Choose Edit  GoTo to display the Go To dialog box, where you can see a list of the view 
names in the worksheet. 

Procedure to display the Calendar 
1. In the worksheet, select a cell within the dimensional model data. 

2. Do one of the following: 

  Click SM Add-In  Calendar. 

  Click the Calendar button on the SM Add-In toolbar. 

  Display the shortcut menu, and then choose Calendar. 
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4.2 Saving an Excel Workbook 
Procedure to save for the first time 
1. Choose File  Save to display the Save As dialog box. Or, click the Save button on the Excel 

toolbar. 

2. If you are saving for the first time, in the Save in drop-down list, specify a drive and location to 
save the workbook to. 

3. Type a name for the file in the File name box, or double-click an existing name in the list box to 
overwrite it with the new version of the workbook. 

4. Make sure the default value of Microsoft Excel Workbook (*.XLS) appears in the Save as type 
list box. 

5. Click Save. 

4.3 Opening an Excel Workbook 
Containing Data 

Procedure 
1. Choose File  Open to display the File Open dialog box. 

2. Select the workbook file containing Application Server data. 

3. Click OK. 

The worksheet that you viewed last in the workbook appears. 

Notes:   

 When you open an Excel workbook containing data from a dimensional model, the data is not 
updated automatically — you can update the data manually, or create a Visual Basic module 
that updates a view when you open a worksheet.  

 Make sure that you open only those Excel workbooks whose Excel sheets display views of just 
the models you are authorized to use.  

4.4 Logging into Interactive Publisher 
4.4.1 Logging into Interactive Publisher 

Procedure 
1. Choose SM Add-In  Login. Or, click the Login/Logout button on the SM Add-In toolbar. 

Depending on how your default login is set up, you may be prompted for different things. 
Excel Add-In attempts to log you into Interactive Publisher using the default login set up in the 
LsViewer.ini file. 

2. If you are prompted for a username and password, type the Interactive Publisher user name 
and Interactive Publisher password. 

3. If you are prompted for a host name, specify the host name where Interactive Publisher 
resides. For example, http://<nw_server>:<port>  where <nw_server> and <port> are the 
server name or IP address and port for the SAP NetWeaver server location and strategy 
management application components location. 

4. The Pathname text box shows you the virtual path and location of the Interactive Publisher 
script program. It says /strategyServer/scriptmain.pw. You can skip over this text box. 
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5. Type the default model to use. 

6. (Optional) Click Save as default to replace the current default values in the lsviewer.ini file with 
the options you specify. The next time this dialog box is displayed, the new options are shown 
as the default values. 

7. Click OK. You are now logged into Interactive Publisher. 

Notes: 

 Depending on how this information is set up in lsviewer.ini, you may not have to enter all the 
information mentioned above. See the topic that explains the [PIPServer] section of lsviewer.ini 
for more information. 

 If you are only viewing or charting the data in the worksheet, you do not need to log in. 

 To create a new worksheet, update data, change the model, drill up or down on data, or 
change the selection or arrangement of data, log into Interactive Publisher. 

 The Login/Logout button is selected when you are logged into the system. 

 Do not include an underscore in any login names. 

4.4.2 Modifying the Default Interactive 
Publisher Login 

Procedure 
1. Open the lsviewer.ini file located in your Windows directory. 

2. Modify the following parameters as appropriate: 
[PIPServer] 

DisplayLogin=Yes|No 
HostName=http://<nw_server>:<port> 
PathName=/strategyServer/scriptmain.pw 
DefaultModel=<model> 

PIPLogin=<Web_auth_user> 
PIPPassword=<Web_auth_password> 

Where: 

http://<nw_server>:<port> is the name and port of the SAP NetWeaver server location. 

/strategyServer/scriptmain.pw specifies the virtual path and name for the Interactive Publisher script 
program. Note: You do not enter a question mark (?) after the Interactive Publisher program in this 
situation because you are entering the program's location rather than a URL address. 

<model> specifies the name of the default model to use. By default, this value is set to Default 
during the installation. If you do not specify anything, then the first available model in alphabetical 
order will be used. 

<web_auth_user >is the name of the Web authentication user logging in. 

<web_auth_pass >is the password for the Web authentication username.  

For more information, see the [PIPServer] topic. 

Notes:  

 To prompt the user with a Login box, specify DisplayLogin=Yes. To log the user in without 
prompting, specify DisplayLogin=No.  

You must be logged into Interactive Publisher in order to change the model. The Login/Logout 
button is selected when you are logged in. 
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4.4.3 Using a different Model 
Procedure 
1. In the worksheet, select a cell to specify the top-left position of the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Model tab. 

4. In the Name box, type a valid model name, or select one from the drop-down list. 

5. Click OK. 

The data from the new dimensional model is displayed at the specified position in the worksheet. 

4.4.4 Changing the Interactive Publisher Login 
Procedure 
1. Click the Login/Logout button on the SM Add-In toolbar to log out of Interactive Publisher. 

2. When the message Logging out. Please confirm appears, click Yes. 

3. Click the Login/Logout button on the SM Add-In toolbar to display the Login box so you can log 
back into Interactive Publisher.  

4. In the Login box, specify new login information and click OK. 

4.4.5 Logging Out of Interactive Publisher 
Procedure 
1. Choose SM Add-In  Logout. Or, click the Login/Logout button on the SM Add-In toolbar. 

2. When the message Logging out. Please confirm appears, do one of the following: 

 Click Yes to log out. 

 Click No to cancel the request. 

Notes: 

 You can save your workbook before or after you log out of Interactive Publisher. 

 You do not need to log out of Interactive Publisher before you exit from an Excel session — 
closing Excel automatically logs you out of Interactive Publisher. 

4.5 Changing the Model Properties 
4.5.1 Adding a Dimension to the View 

Procedure 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Viewer tab. 

4. To add a dimension to the view, select it in the Dimension list box, and then drag it to the 
Across, Down, or Page list box. 

5. Click OK. 



Using Excel Add-In  

 

 

12 September 2011 

Note:  You can add a total of up to 14 dimensions to the Across, Down, and Page views. 

4.5.2 Adding a Member to a Dimension 
Procedure 
1. In the worksheet, select the label of the dimension you want to work with. Or, select a cell 

within the dimensional model data. 

2. Display the Dimensional Selector. 

If you selected a dimension in the worksheet in step 1, the Dimensional Selector displays 
details of the selected dimension — otherwise, details of the Measures dimension (variables) 
are displayed. 

3. In the Hierarchy list box, click the plus symbol (+) beside a dimension to expand the member 
list, or click Expand All to display expanded member lists for all dimensions. 

4. Dimension member names are listed in long or short format depending on the Long 
descriptions setting specified in the Format tab of the Dimensional Model dialog box. If you 
want to override that setting while you are in the Dimensional Selector dialog box, select or 
deselect the Long Names option as appropriate. When Long Names is selected, the long 
names of dimension members appear in the Dimensional Selector dialog box. When Long 
Names is deselected, the short names of dimension members appear in the Dimensional 
Selector dialog box. When you close the Dimensional Selector, the dimension members return 
to the long or short format specified in the Format tab of the Dimensional Model dialog box. 

5. (Optional) To build a list of members that match a specified search string, click the Find 
Members tab. learn more about how to search for members using the Find tab. 

6. Add one or more members to the dimension as follows: 

 To add a member, select it in the Hierarchy list box, and then click Add Marked to add it to 
the Selected members list. Or, double-click the member in the Hierarchy list box. 

 To add all the members at once, click Mark All, and then click Add Marked to add them to 
the Selected members list box. You can add 1024 members at a time. Repeat this step to 
add more than 1024 members. 

7. Select Order on short names to order the members on their short names. Deselect this option 
to order the members by long names. 

This option is available at these times: 

 When you are displaying a measure in the Dimension View tab.  

 When you are displaying a dimension in the Dimension View tab and you are viewing 
members by an alphabetical list. 

 When you are displaying a dimension or measure in the Find Members tab.  Note: This 
option works independently of the Search using options. Regardless of whether you search 
using short and/or long names, you can select or deselect Order on short names to order 
the results based on short names or long names. For example, if you are searching for 
dimensions by long names, you can select this option to order them by their short names. 

8. (Optional) To display the selected members in the order in which they appear in the Selected 
members list box at the time you click OK, select Order as selected. Note: This option is 
applied to the current view only. If you have more than one view, the other views will not be 
affected by this option. 

9.  (Optional) To work with the attributes of the selected dimension, click the Attributes tab. 

You can use attributes to add members to the Selected members list box, or to restrict the 
Selected members list box to display only members that have specific attributes. 
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10. Click OK. 

4.5.3 Changing the Periodicity 
Procedure 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Calendar dialog box. 

3. Make sure the Periodicity tab is selected. 

4. In the Periodicity list box, select a different option. 

5. Click OK. 

The dimensional model data in the worksheet is updated to reflect the changed periodicity. 

Note: If you are displaying a saved Excel Add-In spreadsheet in which a LATEST Timeset is used, 
and  you refresh the view, Excel Add-In updates the dates and data in the spreadsheet to reflect 
any LATEST date changes in Application Server. This is the default behavior. If you do not want to 
pick up the LATEST date from Application Server, but want your spreadsheet to maintain the 
LATEST date as set in the Excel ADD-In Calendar, change the SaveLatestDate setting in the 
LSVIEWER.INI file to SaveLatestDate=1. 

4.5.4 Changing the Time Template 
Procedure 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Calendar dialog box. 

3. Click the Templates tab. 

4. (Optional) In the Template type drop-down list, select a different template type. 

The Templates list box is updated to show time templates based on the selected type. 

5. In the Templates list box, select a time template to apply to the dimensional model data. 

6. Click OK. 

The dimensional model data in the worksheet is updated to reflect the changed time template. 

Note: If you are displaying a saved Excel Add-In spreadsheet in which a LATEST Timeset is used, 
and  you refresh the view, Excel Add-In updates the dates and data in the spreadsheet to reflect 
any LATEST date changes in Application Server. This is the default behavior. If you do not want to 
pick up the LATEST date from Application Server, but want your spreadsheet to maintain the 
LATEST date as set in the Excel ADD-In Calendar, change the SaveLatestDate setting in the 
LSVIEWER.INI file to SaveLatestDate=1. 

4.5.5 Removing Members from Dimensions 
Procedure to remove a member from a dimension 
1. In the worksheet, select the label of the dimension you want to work with. Or, select a cell 

within the dimensional model data. 

2. Display the Dimensional Selector. 

If you selected a dimension in the worksheet in step 1, the Dimensional Selector displays 
details of the selected dimension — otherwise, details of the Measures dimension (variables) 
are displayed. 
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3. In the Hierarchy list box, click the plus symbol (+) beside a dimension to expand the member 
list, or click Expand All to display expanded member lists for all dimensions. 

4. Dimension member names are listed in long or short format depending on the Long 
descriptions setting specified in the Format tab of the Dimensional Model dialog box. If you 
want to override that setting while you are in the Dimensional Selector dialog box, select or 
deselect the Long Names option as appropriate. When Long Names is selected, the long 
names of dimension members appear in the Dimensional Selector dialog box. When Long 
Names is deselected, the short names of dimension members appear in the Dimensional 
Selector dialog box. When you close the Dimensional Selector, the dimension members return 
to the long or short format specified in the Format tab of the Dimensional Model dialog box. 

5. In the Selected members list box, select the member you want to remove, and then click Delete 
Marked. 

6. Click OK. 

Procedure to remove all members from a selected dimension 
1. In the worksheet, select data from the dimension you want to work with. 

2. Display the Dimensional Selector. 

3. Click Delete All. 

4. Click OK. 

4.5.6 Restoring the Default Dimensions 
Procedure 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Viewer tab. 

4. Click Reset. 

The following changes are made: 

 The current Across dimensions are moved into the Dimensions list box. The default across 
dimension, Time, appears in the Across list box. 

 The current Down dimensions are moved into the Dimensions list box. The default down 
dimension, Measures, appears in the Down list box. 

 The current Page dimensions are moved into the Dimensions list box. 

5. Click OK. 

4.5.7 Swapping the Dimension Display 
Direction 

Procedure 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Viewer tab. 

4. Click Swap Across/Down. 

The contents of the Across and Down list boxes are switched simultaneously. 



 Using Excel Add-In 

   

September 2011 15 

5. Click OK. 

4.5.8 Removing a Dimension from the View 
Procedure 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Viewer tab. 

4. To remove a dimension, select it in the Across, Down, or Page list box, and then drag it to the 
Dimension list box. 

5. Click OK. 

Notes: 

 The Time and Measures dimensions must be present in either the Across, Down, or Page list 
boxes — you cannot remove these dimensions from the view. 

 The Across and Down list boxes must always contain at least one dimension. 

4.5.9 Changing the View Appearance 
Procedure to display headings as they exist in the model source 
1. Display the Dimensional Model dialog box. 

2. Click the Format tab. 

3. Deselect Auto format, and then click OK to close the property sheet. 

Procedure to display headings with initial capital letters 
1. Display the Dimensional Model dialog box. 

2. Click the Format tab. 

3. Select Auto format, and then click OK to close the property sheet. 

Procedure to display a progress bar when loading data 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Options tab. 

4. In the Progress Bar group, select Display. 

5. In the Record threshold text box, type a number between 1 and 9999 to specify the number of 
records to load before displaying the progress bar. 

6. Click OK. 

Note:  The default Record threshold value is 10. 

Procedure to display headings 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. To display headings in the across view, select Across headings. 
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5. To display headings in the down view, select Down headings. 

6. Click OK. 

Procedure to display the long names of dimension members 
You can control whether you want to display the short names or the long names of dimension 
members if both short and long names are defined for the members in a Application Server 
dimensional model. 

1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. Select Long descriptions. 

5. Click OK.  

6. The long names of dimensions appear instead of short names. 

Procedure to display the short names of dimension members 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. Deselect Long descriptions. 

5. Click OK.  

6. The short names of dimension members appear instead of long names. 

Procedure to override the session setting in the Dimensional Selector 
dialog box 
While the format setting specifies how you want the dimension members to appear in a persistent 
manner in your session, you can temporarily change that setting in the Dimensional Selector dialog 
box. If long names are displayed in Excel, you can display the short names of dimension members 
in the Dimensional Selector dialog box. If short names are displayed in Excel, you can display the 
long names of dimension members in the Dimensional Selector dialog box.  

1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Selector dialog box. 

3. Select Long Names to display dimension members with their long names. Deselect Long 
Names to display dimension members with their short names. 

4. Click OK.  

5. The dimension member names will appear in this format until you close the Dimensional 
Selector dialog box. 

Procedure to retrieve display data values 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. Select Data values. 

5. Click OK. 
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Note:  If Data values is deselected, headings are retrieved and displayed even though the data 
values are not. 

Procedure to sort the view 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Sort tab. 

4. Select Sorted view. 

5. Make sure By column is selected. 

6. Select Ascending or Descending. 

7. In the Column box, specify the number of the column you want to sort by. 

Note:  Make sure that the column you specify contains values, not labels. 

8. Click OK. 

Note:  You can also sort the view by the last down dimension in three ways — alphabetically, in the 
default hierarchy order, or in the order that the dimension members occur. 

Procedure to sort by dimension members 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Sort tab. 

4. Select Sorted view. 

5. Select By last down. 

6. Select Alphabetical or in hierarchy or Natural Order. 

7. Click OK. 

Procedure to specify how missing values are displayed 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. Do one of the following: 

 To display missing values as blanks, select Missing as blank. 

 To display missing values as a dash ('-'), deselect Missing as blank. 

5. (Optional) Click the Set Defaults button to apply your selections to future views automatically. 

6. Click OK. 

Notes: 

 You can also use the Pilot - Format command with the MissingAsBlank keyword to specify how 
missing values are displayed. 

 When you move data from Application Server to an Excel spreadsheet, some Application 
Server default settings related to missing display options may be lost. By using Set Defaults, 
this assures that missing data is always treated the same way. 

 You can completely suppress the display of rows that contain only missing values. 
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Procedure to set automatic column formatting 
1. Display the Dimensional Model dialog box, and then select the Excel tab. 

2. In the Title Options section, check AutoWidth Data. 

The column sizes are adjusted to fit the data in the columns. When this option is deselected, no 
formatting of column sizes occurs. 

Procedure to suppress the display of missing rows 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. In the Suppress group, select both Missing as blank and Suppress missing rows. 

5. (Optional) Click the Set Defaults button to apply your selections to future views automatically. 

6. Click OK. 

Rows containing only missing values are not displayed. 

Notes: 

 If Zeros as blanks is also selected, rows that contain both missing values and zeros are 
displayed as blanks. 

 When you move data from Application Server to an Excel spreadsheet, some Application 
Server default settings related to zero display options may be lost. By using Set Defaults, this 
assures that zero values are always treated the same way. 

 You can also suppress the display of rows by using the Pilot - Format command with the 
SuppressMissing keyword. 

Procedure to suppress the display of zero values 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. In the Data group, select Zeros as blanks. 

5. (Optional) Click the Set Defaults button to apply your selections to future views automatically. 

6. Click OK. 

Zero values are displayed as blank. 

Notes: 

 If Missing as blank and Suppress missing rows are also selected, rows that contain both 
missing values and zeros are displayed as blanks. 

 When you move data from Application Server to an Excel spreadsheet, some Application 
Server default settings related to zero display options may be lost. By using Set Defaults, this 
assures that zero values are always treated the same way. 

 You can also suppress the display of zero values by using the Pilot - Format command with the 
SuppressZero keyword. 

4.5.10 Changing the Appearance of the View 
Title 
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Procedure to add the model name to the view's title 
1. Display the Dimensional Model dialog box, and then select the Excel tab. 

2. In the Title Options section, check Supply Model Name. 

The name of the dimensional model that the view is based upon, followed by a colon (:), appears at 
the beginning of the view's title. 

Procedure to separate dimension names in the view's title 
1. Display the Dimensional Model dialog box, and then select the Excel tab. 

2. In the Title Options section, check Separate Dimension Names. The name of each dimension 
in the view appears in a separate row in the same column.  

Procedure to display a view with no title 
1. Display the Dimensional Model dialog box, and then select the Excel tab. 

2. In the Title Options section, check No Title. 

The view is displayed without a title. 

4.5.11 Setting View Selections as the Default 
Procedure to set Dimensional Model Format tab selections as the default 
1. Display the Dimensional Model dialog box, and then select the Format tab. 

2. In the Dimensional Model Format tab, select the options that you want to set as the default. 

3. Click the Set Defaults button. 

Your selections are written to the LSVIEWER.INI file, and automatically applied to all new 
Excel Add-In views. 

4. (optional) Click OK to apply your selections to the current view. 

Note: When you move data from Application Server to an Excel spreadsheet, some Application 
Server default settings related to zero display options may be lost. By using Set Defaults, this 
assures that zero values are always treated the same way. 

Procedure to set Dimensional Model Option tab selections as the default 
1. Display the Dimensional Model dialog box, and then select the Option tab. 

2. In the Dimensional Model Option tab, select the options that you want to set as the default. 

3. Click the Set Defaults button. 

Your selections are written to the LSVIEWER.INI file, and automatically applied to all new 
Excel Add-In views. 

4. (optional) Click OK to apply your selections to the current view. 

Procedure to set Dimensional Model Excel tab selections as the default 
1. Display the Dimensional Model dialog box, and then select the Excel tab. 

2. In the Dimensional Model Excel tab, select the options that you want to set as the default. 

3. Click the Set Defaults button. 

Your selections are written to the LSVIEWER.INI file, and automatically applied to all new 
Excel Add-In views. 

4. (optional) Click OK to apply your selections to the current view. 
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4.5.12 Drilling Up and Down 
Procedure to reverse the drill direction when you reach the bottom 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Options tab. 

4. Select Swap direction at bottom. 

5. Click OK. 

Notes: 

 Swap direction at bottom changes the drill direction when you reach the lowest drill down level, 
so that the next time you try to drill down, you start to drill up automatically. The icon on the Drill 
Direction button changes to show that you are drilling up. 

 If Swap direction at bottom is deselected, you can still drill down, but when you reach the 
bottom, a message informs you that further drilling down is not permitted as you have reached 
an input-level dimension member. 

Procedure to reverse the drill direction when you reach the top 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Options tab. 

4. Select Swap direction at top. 

5. Click OK. 

Notes: 

 Swap direction at top changes the drill direction when you reach the top drill down level, so that 
the next time you try to drill up, you start to drill down automatically. The icon on the Drill 
Direction button changes to show that you are drilling down. 

 If Swap direction at top is deselected, you can drill down and back up once. When you reach 
the top, a message informs you that further drilling is not permitted as you have reached a top-
level dimension member. 

Procedure to change the drill direction manually 
On the SM Add-In toolbar, click the Drill Direction button. 

Procedure to specify how headings appear when users drill through the 
data 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. In the Layout drop-down list, select one of the following options: 

 Outline – to display headings indented in a single column, select Outline (the default value).  

 Non-Outline – to display headings in separate columns, and show details for all member 
combinations on a change of member, select Non-outline.  
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 Table – to display headings in separate columns, and show details for all member 
combinations as you drill down, select Table.  

5. Click OK. 

Notes: 

 You can only see the effects of the Layout option if two or more dimensions are shown in the 
down view. 

 You can also specify the heading layout by using a Pilot - Format command as follows: 

 To specify an outline layout, use the Outline keyword with a parameter of On. 

 To specify a non-outline layout, use the Outline keyword with a parameter of Off. 

 To specify a table layout, use the TableOutline keyword with a parameter of On. 

Procedure to display parent member names when drilling 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. Select Show parents. 

5. Click OK. 

When you drill through the data, the top-level dimension member names are shown. 

Procedure to hide parent member names when drilling 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Format tab. 

4. Deselect Show parents. 

5. Click OK. 

When you drill down, by default, the top-level dimension names are hidden. 

Procedure to drill down 
1. In the worksheet, select a cell within the dimensional model data. 

2. Do one of the following: 

  Choose SM Add-In  Drill Down. 

  Click the Drill Direction button on the SM Add-In toolbar so that the button icon shows a 
down arrow. 

  Display the shortcut menu, and then choose Drill Down. 

3. To drill down, double-click the label of the dimension you want to drill. 

Notes: 

 You cannot drill on variables (for example, Costs) or on the Time dimension. 

 You cannot drill on short names that contain a wildcard (*) character. 

Procedure to drill up 
1. In the worksheet, select a cell within the dimensional model data. 
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2. Do one of the following: 

 Choose SM Add-In  Drill Up. 

  Click the Drill Direction button on SM Add-In toolbar so that the button icon shows an up 
arrow. 

  Display the shortcut menu, and then choose Drill Up. 

3. To drill up, double-click the label of the dimension you want to drill. 

Notes: 

 You cannot drill on variables (for example, Costs) or on the Time dimension. 

 You cannot drill on short names that contain a wildcard (*) character. 

Procedure to enable drilling 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Options tab. 

4. Make sure Protected view is deselected. 

5. Click OK. 

Notes: 

 If Protected view is deselected, when you double-click a heading, you drill down automatically 
to the next level of data. 

 If Protected view is deselected, headings are shown in bold type. 

Procedure to prevent drilling 
1. In the worksheet, select a cell within the dimensional model data. 

2. Display the Dimensional Model dialog box. 

3. Click the Options tab. 

4. Select Protected view. 

5. Click OK. 

Notes: 

 If Protected view is selected, nothing happens when you double-click a heading. 

 If Protected view is selected, headings are shown in normal text. 

 You cannot drill on short names that contain a wildcard (*) character. 

4.6 Customizing the SM Add-In Toolbar 
4.6.1 Adding a Button to the Toolbar 

Procedure 
1. Right mouse click over the SM Add-In menu or toolbar and then choose Customize to display 

the Customize dialog box. 

2. In the Customize dialog box, select the Commands tab. 

3. In the Categories list box, highlight the Macros item. 
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4. In the Commands list box, highlight the Custom Button. 

Note: If you want to display a list of available macros from which you can select the macro 
you want to run, rather than assign a single macro to a toolbar item, skip step 4. 

5. Drag the Custom Button item from the dialog box to the SM Add-In toolbar. 

6. Immediately after you drop the new toolbar icon onto the SM Add-In toolbar, you should see a 
new option, called Modify Selection, available in the Commands dialog box. Click on the Modify 
Selection hotspot and select Assign Macro. 

7. From the Assign Macro dialog box, highlight the name of the macro that you want to assign to 
the toolbar button and then click OK. 

8. Click Close to close the Customize dialog box.  Click on the new toolbar button you added to 
the SM Add-In  toolbar.   

Notes:   

 A custom button can be placed at the end of the SM Add-In toolbar, or in between existing SM 
Add-In toolbar buttons, but it cannot be placed at the beginning of the SM Add-In toolbar. 

 There are other methods of creating toolbar buttons in Microsoft Excel, depending upon the 
version of Excel that you are running. For more information, see Microsoft Excel Help. 

4.6.2 Moving the Toolbar on the Worksheet 
You can move the SM Add-In toolbar on the worksheet, change its shape between horizontal and 
vertical, or add the toolbar to the Excel toolbar. 

When you begin a new Excel session, the SM Add-In toolbar appears in the same position as when 
you last closed Excel. 

 To move the toolbar, drag the toolbar caption on the worksheet. 

 To add the toolbar to the Excel toolbar, drag the SM Add-In toolbar caption to the Excel toolbar. 

 To add the toolbar to the end of the Excel toolbar, double-click the SM Add-In toolbar caption. 

 To change the shape of the toolbar, position the pointer over a corner of the SM Add-In toolbar 
so that a two-headed arrow appears. Drag the pointer to change the shape of the toolbar 
horizontally or vertically. 

4.7 Working with Data 
4.7.1 Changing the Data Format 

Procedure 
1. Select the cells containing the data you want to format. 

2. Choose Format  Cells to display the Format Cells dialog box. Or, display the shortcut menu, 
and then choose Format Cells. 

3. Use the Format Cells dialog box to change the attributes of the selected cells as required, and 
then click OK. 

Notes: 

 By default, cells containing numeric data are formatted as Arial 10pt, numeric, right aligned. 

 By default, Excel Add-In uses the decimal place and thousand separators specified in the 
International section of the Windows initialization file (WIN.INI). 
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4.7.2 Changing the View 
Procedure 
1. Select the text you want to format. Or, select the view and page label row. 

2. Choose Format  Cells to display the Format Cells dialog box. Or, display the shortcut menu, 
and then choose Format Cells. 

3. Use the Format Cells dialog box to change the attributes of the selected cells as required, and 
then click OK. 

Note:  By default, view and page labels are displayed in the first row of the dimensional model data 
in the Excel spreadsheet. The cells are formatted as Arial 10pt bold text, dark blue, and left aligned. 

4.7.3 Changing the Across Label Format 
Procedure 
1. Select the text you want to format. Or, select one or more label rows. 

2. Choose Format  Cells to display the Format Cells dialog box. Or, display the shortcut menu, 
and then choose Format Cells. 

3. Use the Format Cells dialog box to change the attributes of the selected cells as required, and 
then click OK. 

Note:  By default, cells containing across labels are formatted as Arial 10pt bold text, center 
aligned. 

4.7.4 Changing the Down Label Format 
Procedure 
1. Select the text you want to format. Or, select one or more label columns. 

2. Choose Format  Cells to display the Format Cells dialog box. Or, display the shortcut menu, 
and then choose Format Cells. 

3. Use the Format Cells dialog box to change the attributes of the selected cells as required, and 
then click OK. 

Note:  By default, down labels are formatted in outline view as Arial 10pt bold text, left aligned. 

4.7.5 Copying Data Between Worksheets 
Procedure 
1. In the first worksheet, select the range of data to be copied. 

2. Choose Edit  Copy. 

3. Click the label of the target worksheet. 

4. Choose Edit  Paste. 

A copy of the data appears on the target worksheet. The dimensions and variables are 
arranged as specified in the Dimensional Model dialog box. 

5. (Optional) Display the Dimensional Model dialog box and change the view as required. 

4.7.6 Displaying a Different Page 
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 To display the next page, in the worksheet, select a cell within the dimensional model data. 
Then click the Next Page button on the SM Add-In toolbar. 

 To display the previous page, in the worksheet, select a cell within the dimensional model data. 
Then click the Previous Page button on the SM Add-In toolbar. 

 To go to a specified page, in the worksheet, select a cell within the dimensional model data. 
Click the Go To Page button on the SM Add-In toolbar to display the Go To Page dialog box. In 
the list box, select a page, and then click OK. 

 To display a single view on a worksheet, make sure you are logged in to Application Server. In 
the worksheet, select a cell to specify the top-left position of the dimensional model data. 
Display the Dimensional Model dialog box. Work with the view as required, and then click OK. 

The dimensional model data is displayed in the worksheet, starting from the selected cell. 

Notes: 

 You can display a single view, or multiple views, on multiple worksheets within a workbook. 

 You can display a maximum of 15,000 rows from a dimensional model source on a worksheet. 

4.7.7 Displaying Multiple Views on a Single 
Worksheet 

Procedure 
1. Insert the first view into the worksheet. 

2. In the worksheet, select a cell to specify the top-left position of the second set of dimensional 
model data. 

3. Display the Dimensional Model dialog box. 

4. Work with the second view as required, and then click OK. 

The second set of dimensional model data is displayed in the worksheet, starting from the 
selected cell. 

5. Repeat steps 2 to 4 as required. 

Notes: 

 There is no limit to the number of views you can display on a single worksheet. However, you 
can display a maximum of 15,000 rows from a dimensional model source. 

 You can display a single view, or multiple views, on multiple worksheets within a workbook. 

 You can use the Order as Selected option independently in both views. That is, if you use it in 
one view, it will not affect the other view. 

 Excel Add-In displays a warning message if existing dimensional model data is about to be 
overwritten (for example, if two views overlap on a worksheet). 

4.7.8 Removing Data from a Worksheet 
Procedure 
1. In the worksheet, select one or more cells within the dimensional model data. 

2. Choose SM Add-In  Delete. 

3. When a message appears, asking whether to Clear area under view?, do one of the following: 

 Click Yes to break the link to Application Server and remove the data in the worksheet. 
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 Click No to break the link to Application Server, but keep the currently displayed view of the 
data in the worksheet. 

 Click Cancel to cancel the delete request. 

Note:  If you click No, or if you click Yes and then undo the deletion by choosing Edit  Undo 
Clear, you will be unable to perform operations such as drilling and changing the view on the 
displayed data. 

4.7.9 Selecting Data 
 To select a single cell, click the cell. 

 To select a range of cells, click the top-left cell of the range, and then hold down Shift and click 
the bottom-right cell of the range. Or in the Excel Name box (at the left end of the Function 
bar), type the cell range you want to select, separated by a colon (:). For example, A1:D5. 

 To select a row, click the row heading. 

 To select a column, click the column heading. 

Note:  For more information about selecting cells in Excel, see Microsoft Excel Help. 

You can create a Visual Basic module that updates one or more views automatically when you 
open a worksheet. 

4.7.10 Updating Data in a Worksheet 
Procedure 
1. Make sure that you are logged in to Application Server to update the worksheet manually with 

the latest data in the Application Server model. 

2. Choose SM Add-In  Refresh. Or, click the Refresh button on the SM Add-In toolbar. 

The worksheet displays the most current data from the Application Server model. 

Notes: 

 The worksheet is updated automatically if you change the dimension or variable selection in the 
Dimensional Model dialog box. 

 The dimensional model must be available at the time you update the data. Otherwise, you will 
receive unpredictable results. 

 Cells retain their formatting (for example, font, color, and shading) when you update, add, or 
remove data on the worksheet. However, user-defined values or formulas within the cells of the 
query are not retained when you update the worksheet. 

 When you open an Excel workbook containing data from a dimensional model, the data is not 
updated automatically — you can update the data manually, or create a Visual Basic module 
that updates a view when you open a worksheet.. 

 If you refresh a saved Excel Add-In spreadsheet in which a LATEST Timeset is used, Excel 
Add-In updates the dates and data in the spreadsheet to reflect any LATEST date changes in 
Application Server. This is the default behavior. If you do not want to pick up the LATEST date 
from Application Server, but want your spreadsheet to maintain the LATEST date as set in the 
Excel ADD-In Calendar, change the SaveLatestDate setting in the LSVIEWER.INI file to 
SaveLatestDate=1. 
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5 Calendar Reference 
5.1 Periodicities 

By default, data is displayed in a dimensional model at the periodicity specified when the variables 
were created in the dimensional model. You can use the Calendar dialog box to change the 
periodicity at which your data is displayed. For example, if your data is stored weekly, select a 
different periodicity in the Calendar dialog box to display the data biweekly, monthly, yearly, and so 
on. 

Notes:   

 You can select either a periodicity or time template in the Calendar dialog box, not both 
together. 

 If you are displaying a saved Excel Add-In spreadsheet in which a LATEST Timeset is used, 
and you refresh the view, Excel Add-In updates the dates and data in the spreadsheet to reflect 
any LATEST date changes in Application Server. This is the default behavior. If you do not 
want to pick up the LATEST date from Application Server, but want your spreadsheet to 
maintain the LATEST date as set in the Excel ADD-In Calendar, change the SaveLatestDate 
setting in the LSVIEWER.INI file to SaveLatestDate=1. 

5.1.1 Bimonthly 
Periodicity description 
Displays data for each two-month period. 

Example 
This example shows several gross Sales values for a model with a Calendar start date of 
January 2, 2009: 

Jan - Feb 09 12,875,050.00 

Mar - Apr 09 11,616,017.50 

May - Jun 09 11,491437.00 

5.1.2 Biweekly 
Periodicity description 
Displays data for each two-week period. 

Example 
This example shows several gross Sales values for a model with a Calendar start date of 
January 2, 2009: 

01 Jan - 14 Jan 09 2,552,923.48 

15 Jan - 28 Jan 09 2,736,415.00 

29 Jan - 11 Feb 09 3,286,490.48 

12 Feb - 25 Feb 09 3,486,554.21 

5.1.3 Daily 
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Periodicity description 
Displays data for each day. 

Example 
This example shows several gross Sales values for a model with a Calendar start date of 
January 2, 2009: 

02 Jan 09 983,980.00 

03 Jan 09 883,860.00 

04 Jan 09 543,970.00 

05 Jan 09 750,789.00 

06 Jan 09 870,456.00 

5.1.4 Hourly 
Periodicity description 
Displays data for each hour. 

Example 
This example shows several gross Sales values for a model with a Calendar start date of 
January 2, 2009: 

1 am 02 Jan 980.00 

2 am 02 Jan 980.00 

3 am 02 Jan 980.00 

4 am 02 Jan 980.00 

5 am 02 Jan 980.00 

6 am 02 Jan 980.00 

7 am 02 Jan 980.00 

8 am 02 Jan 980.00 

9 am 02 Jan 980.00 

10 am 02 Jan 1050.00 

11 am 02 Jan 1250.00 

Note:  If a message is displayed, advising you that the data exceeds the maximum number of 
observations, request that your database administrator changes the model within Application 
Server. 

5.1.5 Lunar 
Periodicity description 
Displays data for each 28-day period. 

Example 
This example shows several gross Sales values for a model with a Calendar start date of 
January 2, 2009 and an end date of May 31, 2009: 

28 Jan 09 11,586,957.29 
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25 Feb 09 14,419,289.88 

24 Mar 09 13,327,109.41 

21 Apr 09 12,365,095.92 

19 May 09 12,331,234.89 

5.1.6 Lunar to Date 
Periodicity description 
Displays data for each lunar month, up to the Calendar end date. Data for previous years is only 
displayed up to the same date as the end date. For example, if the end date is May 31, 2009, data 
for previous years is displayed up to May 31. 

Example 
This example shows several gross Sales values for a model with a Calendar start date of 
January 2, 2009 and an end date of May 31, 2009: 

28 Jan 09 11,586,957.29 

25 Feb 09 14,419,289.88 

24 Mar 09 13,327,199.41 

21 Apr 09 12,365,095.92 

19 May 09 12,331,234.89 

5.1.7 Monthly 
Periodicity description 
Displays data for each month between the Calendar start and end dates. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2009 
and an end date of May 31, 2009: 

Jan 09 12,828,417.00 

Feb 09 15,286,283.00 

Mar 09 14,490,881.00 

Apr 09 12,989,945.00 

May 09 13,761,147.00 

5.1.8 Monthly to Date 
Periodicity description 
Displays data for each month, up to the Calendar end date. Data for previous years is only 
displayed up to the same date as the end date. For example, if the end date is May 31, 2009, data 
for previous years is displayed up to May 31. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2009 
and an end date of May 31, 2009: 
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29 Jan 09 11,586,957.00 

26 Feb 09 14,532,583.19 

25 Mar 09 13,267,533.98 

22 Apr 09 12,330,646.31 

20 May 09 12,342,144.69 

5.1.9 Qtr Hourly 
Periodicity description 
Displays data for each quarter-hourly point. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2009: 

12.00 J 2 579.60 

12.15 J 2 579.60 

12.30 J 2 579.60 

12.45 J 2 579.60 

1.00 J 2 579.60 

Note:  If a message is displayed, advising you that the data exceeds the maximum number of 
observations, request that your database administrator changes the model within Application 
Server. 

5.1.10 Qtrly to Date 
Periodicity description 
Displays data for each quarter, up to the Calendar end date. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2008 
and an end date of May 31, 2009: 

Jan-Mar Qtd 28,114,700.00 

Apr-Jun Qtd 26,751,092.00 

Jul-Sep Qtd 27,158,206.00 

Oct-Dec Qtd 26,645,774.00 

Jan-Mar Qtd 37,642,856.00 

Apr-Jun Qtd 37,371,054.00 

5.1.11 Quarterly 
Periodicity description 
Displays data for each quarter, or three-month period, within the Calendar start and end dates. 
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Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2009 
and an end date of May 31, 2009: 

Jan-Mar 09 42,605,581.00 

Apr-Jun 09 40,752,619.00 

5.1.12 Rolling Monthly 
Rolling periodicities operate independently of the nominal year, quarter, or month. You can use 
rolling periodicities to look at a period of time as if it were a year, quarter, or month. 

Periodicity description 
Displays data in four-week blocks. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2009: 

15/01/09 834,629.33 

12/02/09 1,764,098.46 

11/03/09 1,914,337.46 

08/04/09 1,714,422.98 

06/05/09 1,626,057.88 

03/06/09 1,395,092.52 

5.1.13 Rolling Qtrly 
Rolling periodicities operate independently of the nominal year, quarter, or month. You can use 
rolling periodicities to look at a period of time as if it were a year, quarter, or month. 

Periodicity description 
Displays data in three-month blocks. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2009: 

Jan-Mar 09 5,742,911.87 

Apr-Jun 09 5,056,326.75 

5.1.14 Rolling Yearly 
Rolling periodicities operate independently of the nominal year, quarter, or month. You can use 
rolling periodicities to look at a period of time as if it were a year, quarter, or month. 

Periodicity description 
Displays data in 12-month blocks. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2008: 

2008 10,799,238.63 
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2009 26,361,835.88 

5.1.15 Semi Annual 
Periodicity description 
Displays data for six-month periods. 

Example 
This example shows gross Sales values for a model with a Calendar start date of January 2, 2008 
and an end date of May 31, 2009: 

Jan-Jun 08 82,605,581.00 

Jul-Dec 08 80,752,619.00 

Jan-Jun 09 86,989,486.00 

5.1.16 Weekly 
Periodicity description 
Displays data for each week. 

Example 
This example shows gross Sales values for January for a model with a Calendar start date of 
January 2, 2009: 

08 Jan 09 4,833,055.00 

15 Jan 09 4,083,860.00 

22 Jan 09 3,543,970.00 

29 Jan 09 3,780,789.00 

5.1.17 Weekly to Date 
Periodicity description 
Displays data for each week, up to the Calendar end date. 

Example 
This example shows gross Sales values for January for a model with a Calendar start date of 
January 2, 2009: 

08 Jan 09 2,058,972.77 

15 Jan 09 2,058,972.77 

22 Jan 09 2,058,972.77 

29 Jan 09 2,058,972.77 

05 Feb 09 2,474,175.35 

12 Feb 09 2,640,256.38 

5.1.18 Yearly 
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Periodicity description 
Displays data for each year within the Calendar start and end dates. 

Example 
This example shows the gross Sales value for a model with a Calendar start date of 
January 2, 2008 and an end date of December 31, 2008: 

2008 542,286,210.00 

5.1.19 Year to Date 
Periodicity description 
Displays data for each year, up to the Calendar end date. 

Example 
This example shows the gross Sales value for a model with a Calendar start date of 
January 2, 2009: 

2009 Ytd 30,601,597.00 

5.2 Time Templates 
You can use time templates to do the following: 

 Display data at more than one periodicity. For example, you can display monthly and year to 
date data in the view. 

 Compare data from different time periods. For example, you can calculate the percentage 
change in sales between the current month and the same month a year ago, and display the 
result in the view. 

 Change the order in which you display data. 

5.2.1 Defining which time templates to use 
You can define which time templates to display in the Periodicity and Templates tabs of the 
Calendar by creating a definitions document. 

When you start the Calendar, the program searches for the definitions document first in the current 
Application Server USE database, and then, if it is not found, in the APLIB database. If no 
definitions document is found in either database, or if the Calendar is launched without a 
connection to Application Server, the default periodicities and time templates provided with product 
are used. 

The name of the definitions document is based on the locale setting in the format CAL_LNG, where 
LNG is the standard locale suffix (for example, the English version must be called CAL_ENG). 
Default versions of the CAL_LNG documents that define the Periodicity, Year to Date, and % 
Change lists are provided in the APLIB database. To add or delete time sets from the default lists, 
or to create your own lists, modify the appropriate document for your locale setting. 

Format of the definitions document 
The definitions document must be in a specific format, as follows: 

[ 

PERIOD 

 [periodicity]* 
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] 

[ 

CATEGORY [category] 

 [shortname longname]* 

]* 

 

where: 

periodicity specifies the internal Application Server periodicities 
category specifies the category name 
shortname specifies the time set short name as it exists in the database 
longname specifies the descriptive name to display for the template in the Calendar 
[ ]* indicates a syntax that may be repeated 
The PERIOD section of the definitions document is used to customize the list of built-in Application 
Server periodicities that are displayed in the Periodicity list on the Periodicity tab of the Calendar. 

Within the document, you can specify up to 20 CATEGORY sections, each containing a separate 
list of templates that can be selected from the Templates list on the Template tab of the Calendar. 
You can also include time templates that reside in other attached databases (see Example 3). 

The category name is separated from the CATEGORY keyword by one or more spaces. You must 
specify the time template short name and long name for each entry, separated by a TAB character. 

In addition to templates defined in the document, user-defined time templates that reside in your 
WORK and USE databases appear in the Calendar Templates list as "Work database" and "Use 
database". 

Notes: 

 For more information about time templates, see Application Server Help. 

 From version 6.0, the NOPERIOD, NOYTD and NOCHNG documents are no longer used to 
customize the Calendar Templates lists. 

5.2.2 User-defined time templates 
You have more flexibility using time templates in the Calendar. You can define the behavior of the 
Calendar from each time template. 

By using the following keyword as the first line of a user-defined time template in your Application 
Server model, you can control several aspects of how the calendar functions. You precede this line 
with ellipses (...): 

...TemplateDates={Latest|Both} 

The following Calendar options and Application Server commands issued by the Calendar, are 
controlled by the content of TemplateDates in all time templates used by the Calendar: 

 Start Date field in the Calendar (active or inactive) 

 SET PERIOD command sent to Application Server 

 SET EARLIEST command sent to Application Server 

 SET LATEST command sent to Application Server 

The following table describes the actions and options performed by the calendar depending on the 
value of TemplateDates: 



 Calendar Reference 

   

September 2011 35 

TemplateDates  
value 

Start Date  
field 

Set Period  
value 

Set Earliest  
value 

Set Latest  
value 

Latest inactive Default start date end date 

Both active start-end start date end date 

Note: If you are displaying a saved Excel Add-In spreadsheet in which a LATEST Timeset is used, 
and you refresh the view, Excel Add-In updates the dates and data in the spreadsheet to reflect any 
LATEST date changes in Application Server. This is the default behavior. If you do not want to pick 
up the LATEST date from Application Server, but want your spreadsheet to maintain the LATEST 
date as set in the Excel ADD-In Calendar, change the SaveLatestDate setting in the 
LSVIEWER.INI file to SaveLatestDate=1. 

Defining an alternative long description for a template 
You can now use the "...Description=description" specification to define an alternative long 
description for a user-defined template found in the WORK or USE databases. For example: 

...TemplateDates=Latest 

...Description=Favorite view 
Note:  For more information about time templates, see Application Server Help. 

5.2.3 Year to date time templates 
This table lists the year to date time templates and their short names. For more information about 
time templates, click an underlined topic. 

Template long name Template short name 
Last 12 Months Ytd CMTYD 
Latest Day v Ytd DAYYTD 
Latest Mtd v Prior MTDLASTMTD 
Latest Mtd v Yr ago MTDLASTYEARMTD 
Latest Qtd v Prior QTDLASTQTD 
Latest Qtd v Yr ago QTDLASTYEARQTD 
Latest Wtd v Prior WTDLASTWTD 
Latest Wtd v Yr Ago WTDLASTYEARWTD 
Latest Ytd v Prior YTDLASTYTD 
Mon/Prior, Yr/Prior MONPMONYRPYR 
Mon/Yr v Prior MONYRMONPYR 
Month/Ytd MONTHYTD 
Q1-Q4/Ytd QQQQTYD 
Quarter/Ytd QTRYTD 
Week/Ytd WEEKYTD 
Ytd ONLYYTD 

5.2.3.1 Last 12 Months Ytd 
Template description 
Displays up to 12 columns of monthly data on a year to date (YTD) basis, ending with the most 
current month. 
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Template short name 
CMYTD 

Example 
This example shows gross Sales for a model with a Calendar latest date of May 28, 2009: 

Jan 09 Ytd  68,339,832.00 

Feb 09 Ytd 139,596,952.00 

Mar 09 Ytd 215,210,480.00 

Apr 09 Ytd 290,921,808.00 

May 09 Ytd 371,669,888.00 

5.2.3.2 Latest Day v Ytd 
Template description 
Displays the latest daily data point and the year to date (YTD) value through that point. 

Template short name 
DAYYTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

5/28 2,883,860.00 

Ytd 371,669,888.00 

5.2.3.3 Latest Mtd v Prior 
Template description 
Displays the latest month period on a month to date (MTD) basis compared with the preceding 
month. Do not use this template unless your data is stored in periods smaller than monthly. 

Template short name 
MTDLASTMTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 09 Mtd 80,748,080.00 

Apr 09 Mtd 75,711,328.00 

 

5.2.3.4 Latest Mtd v Yr ago 
Template description 
Displays the latest month period on a month to date (MTD) basis compared with the same period 
one year ago. Do not use this template unless your data is stored in periods smaller than monthly. 

Template short name 
MTDLASTYEARMTD 
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Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 09 Mtd 80,748,080.00 

May 08 Mtd 45,888,920.00 

5.2.3.5 Latest Qtd v Prior 
Template description 
Displays the current quarter to date (QTD) compared with the preceding quarter to date. 

Template short name 
QTDLASTQTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Apr-Jun Qtd 156,459,408.00 

Jan-Mar Qtd 139,596,952.00 

5.2.3.6 Latest Qtd v Yr ago 
Template description 
Displays the current quarter to date (QTD) compared with the same period one year ago. 

Template short name 
QTDLASTYEARQTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Apr-Jun Qtd 156,459,408.00 

Apr-Jun Qtd  91,526,720.00 

5.2.3.7 Latest Wtd v Prior 
Template description 
Displays the latest week to date (WTD) compared with the preceding period. 

Template short name 
WTDLASTWTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

28 May 09 20,187,020.00 

21 May 09 20,187,020.00 

5.2.3.8 Latest Wtd v Yr Ago 
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Template description 
Displays the latest week to date (WTD) compared with the same period one year ago. 

Template short name 
WTDLASTYEARWTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

28 May 09 20,187,020.00 

29 May 08 11,472,230.00 

5.2.3.9 Latest Ytd v Prior 
Template description 
Displays the latest year to date (YTD) data compared with the data from one year ago. 

Template short name 
YTDLASTYTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

2009 Ytd 371,669,888.00 

2008 Ytd 217,624,872.00 

5.2.3.10 Mon/Prior, Yr/Prior 
Template description 
Displays values for the latest month and the same month in the previous year, and year to date 
values for the current and previous years. 

Template short name 
MONPMONYRPYR 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 2009  80,748,080.00 

May 2008  45,888,920.00 

2009 Ytd 371,669,888.00 

2008 Ytd 217,624,872.00 

5.2.3.11 Mon/Yr v Prior 
Template description 
Displays the latest month and year to date values for the current year and the previous year. 

Template short name 
MONYRPMONPYR 
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Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 2009  80,748,080.00 

2009 Ytd 371,669,888.00 

May 2008  45,888,920.00 

2008 Ytd 217,624,872.00 

5.2.3.12 Month/Ytd 
Template description 
Displays the latest month and year to date values for the current year. 

Template short name 
MONTHYTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 2009  80,748,080.00 

2009 Ytd 371,669,888.00 

5.2.3.13 Q1-Q4/Ytd 
Template description 
Displays quarterly and year to date values for the previous year. 

Template short name 
QQQQYTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Jan-Mar 08 126,098,152.00 

Apr-Jun 08 139,149,292.00 

Jul-Sept 08 158,062,580.00 

Oct-Dec 08 178,320,816.00 

2008  601,630,840.00 

5.2.3.14 Quarter/Ytd 
Template description 
Displays the latest quarter and year to date values for the current year. 

Template short name 
QTRYTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2008: 



Calendar Reference  

 

 

40 September 2011 

Apr-Jun 2008 238,981,616.00 

2008 Ytd 371,669,888.00 

5.2.3.15 Week/Ytd 
Template description 
Displays the latest week and year to date values for the current year. 

Template short name 
WEEKYTD 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

28 May 09  20,187,020.00 

2009 Ytd 371,669,888.00 

5.2.3.16 Ytd 
Template description 
Displays the latest year to date value for the current year. 

Template short name 
ONLYYTD 

Example 
This example shows the gross Sales value for a model with a Calendar latest date of May 28, 2009: 

2009 Ytd 371,669,888.00 

5.2.4 % Change time templates 
% Change template short names 
This table lists the % change time templates and their short names. For more information about 
time templates, click an underlined topic. 

Template long name Template short name 
Latest 4 Quarters QRTRLY 
Latest 12 Month MNTHLY 
Latest 13 Weeks WKLY1 
Latest 14 Days DLY 
Latest Day v Yr ago DAYLY 
Latest Month v Prior MONLASTMON 
Latest Month v Yr ago MONLASTYEARMON 
Latest Qtr v Prior QUALASTQUA 
Latest Qtr v Yr ago QUALASTYEARQUA 
Latest Semi v Prior SEMILY 
Latest Week v Prior WEELASTWEE 
Latest Week v Yr Ago WEELASTYEARWEE 
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Latest Year v Prior YEALASTYEA 
Lunar Latest v Prior LUNLASTLUN 
Lunar Latest v Yr ago LUNLASTYEARLUN 
Month v Prior/% Chg MTHLY 
Prior Mth v Var VLY 
Qtr v Prior/% Chg QTRLY 
Week v Prior/% Chg WKLY 
Year v Prior/% Chg YRLY 
Ytd v Prior/% Chg YTDLY 

5.2.4.1 Latest 4 Quarters 
Template description 
Displays the last four quarters, though the current period. 

Template short name 
QRTRLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Jul-Sep 08 158,062,580.00 

Oct-Dec 08 178,320,816.00 

Jan-Mar 09 215,210,480.00 

Apr-Jun 09 238,981,616.00 

5.2.4.2 Latest 12 Month 
Template description 
Displays the last 12 months of data, through the current month. 

Template short name 
MNTHLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Jun 08 47,622,572.00 

Jul 08 49,327,344.00 

Aug 08 51,919,672.00 

Sep 08 56,815,564.00 

Oct 08 57,681,632.00 

Nov 08 59,990,968.00 

Dec 08 60,648,216.00 

Jan 09 68,339,832.00 

Feb 09 71,257,120.00 
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Mar 09 75,613,528.00 

Apr 09 75,711,328.00 

May 09 80,748,080.00 

5.2.4.3 Latest 13 Weeks 
Template description 
Displays the last 13 weeks of weekly data. 

Template short name 
WKLY1 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

05 Mar 09 15,122,705.60 

12 Mar 09 15,122,705.60 

19 Mar 09 15,122,705.60 

26 Mar 09 15,122,705.60 

02 Apr 09 15,122,705.60 

09 Apr 09 18,927,832.00 

16 Apr 09 18,927,832.00 

23 Apr 09 18,927,832.00 

30 Apr 09 18,927,832.00 

07 May 09 20,187,020.00 

14 May 09 20,187,020.00 

21 May 09 20,187,020.00 

28 May 09 20,187,020.00 

5.2.4.4 Latest Day v Yr ago 
Template description 
Displays the latest daily data point against the same point one year ago. 

Template short name 
DAYLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

5/28/09 2,883,860.00 

5/28/08 1,638,890.00 

% Change 75.96 

5.2.4.5 Latest Month v Prior 
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Template description 
Displays the latest month against the preceding month. 

Template short name 
MONLASTMON 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 09 80,748,080.00 

Apr 09 75,711,328.00 

5.2.4.6 Latest Month v Yr ago 
Template description 
Displays the latest month compared with the same month last year. 

Template short name 
MONLASTYEARMON 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 09 80,748,080.00 

May 08 45,888,920.00 

5.2.4.7 Latest Qtr v Prior 
Template description 

Displays the latest quarter compared with the preceding quarter. 

Template short name 

QUALASTQUA 

Example 

This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Apr-Jun 09 238,981,616.00 

Jan-Mar 09 215,210,480.00 

5.2.4.8 Latest Qtr v Yr ago 
Template description 
Displays the latest quarter compared with the same period one year ago. 

Template short name 
QUALASTYEARQUA 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Apr-Jun 09 238,981,616.00 
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Apr-Jun 08 139,149,292.00 

5.2.4.9 Latest Semi v Prior 
Template description 
Displays the latest half year period compared with the preceding period, and shows the percentage 
change between them. 

Template short name 
SEMILY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Half1 09 454,192,096.00 

Half1 08 265,247,444.00 

% Change 71.23 

5.2.4.10 Latest Week v Prior 
Template description 
Displays the latest weekly period against the preceding period. 

Template short name 
WEELASTWEE 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

28 May 09 20,187,020.00 

21 May 09 20,187,020.00 

5.2.4.11 Latest Week v Yr Ago 
Template description 
Displays the latest weekly period against the same period one year ago. 

Template short name 
WEELASTYEARWEE 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

28 May 09 20,187,020.00 

29 May 08 11,472,230.00 

5.2.4.12 Latest Year v Prior 
Template description 
Displays the data for the latest year compared with the data from one year ago. 
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Template short name 
YEALASTYEA 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

2009 985,564,392.00 

2008 601,630,840.00 

5.2.4.13 Lunar Latest v Prior 
Template description 
Displays the current Lunar to Date period compared with the preceding lunar (28 day) period. 

Template short name 
LUNLASTLUN 

Example 
This example shows Sales values for a model with a Calendar latest date of December 3, 2008: 

03 Dec 08 537,975.00 

05 Nov 08 589,069.00 

5.2.4.14 Lunar Latest v Yr ago 
Template description 
Displays the current lunar period compared with the same period one year ago. 

Template short name 
LUNLASTYEARLUN 

Example 
This example shows Sales values for a model with a Calendar latest date of December 3, 2008: 

03 Dec 08 537,975.00 

03 Dec 07 518,654.00 

5.2.4.15 Month v Prior/% Chg 
Template description 
Displays values for the latest month, the same month in the previous year, and the percentage 
change between the values. 

Template short name 
MTHLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 09 80,748,080.00 

May 08 45,888,920.00 
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% Change 76.00 

5.2.4.16 Qtr v Prior/% Chg 
Template description 
Displays values for the latest quarter, the same quarter in the previous year, and the percentage 
change between the values. 

Template short name 
QTRLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

Qtr 2 09 238,981,616.00 

Qtr 2 08 139,149,292.00 

% Change 72.00 

5.2.4.17 Prior Mth v Var 
Template description 
Compares the latest period to the same period one year ago, but displays Prior Yr followed by the 
variance of this year to last year. 

Template short name 
VLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

May 07 45,888,920.00 

Variance 34,859,160.00 

5.2.4.18 Week v Prior/% Chg 
Template description 
Displays values for the latest week, the same week in the previous year, and the percentage 
change between the values. 

Template short name 
WKLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

28 May 09 20,187,020.00 

29 May 08 11,472,230.00 

% Change 76.00 

5.2.4.19 Year v Prior/% Chg 
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Template description 
Displays values for the current and previous years, and the percentage change between the 
values. 

Template short name 
YRLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of 
December 28, 2008: 

2008 985,564,392.00 

2007 601,630,840.00 

% Change 64.00 

5.2.4.20 Ytd v Prior/% Chg 
Template description 
Displays year to date (Ytd) values for the current and previous years, and the percentage change 
between the values. 

Template short name 
YTDLY 

Example 
This example shows gross Sales values for a model with a Calendar latest date of May 28, 2009: 

2009 Ytd 371,669,888.00 

2008 Ytd 217,624,872.00 

% Change 71.00 


